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 44 

SUMMARY: 45 

 46 

Here, we present a combinatorial approach using high-resolution microscopy, computational 47 

tools, and single-cell labeling in living C. elegans embryos to understand single cell dynamics 48 

during neurodevelopment.  49 

 50 

ABSTRACT:  51 

 52 

Caenorhabditis elegans (C. elegans) stands out as the only organism in which the challenge of 53 

understanding the cellular origins of an entire nervous system can be observed, with single cell 54 

resolution, in vivo. Here, we present an integrated protocol for the examination of 55 

neurodevelopment in C. elegans embryos. Our protocol combines imaging, lineaging and 56 

neuroanatomical tracing of single cells in developing embryos. We achieve long-term, four-57 

dimensional (4D) imaging of living C. elegans embryos with nearly isotropic spatial resolution 58 

through the use of Dual-view Inverted Selective Plane Illumination Microscopy (diSPIM). Nuclei 59 

and neuronal structures in the nematode embryos are imaged and isotropically fused to yield 60 

images with resolution of ~330 nm in all three dimensions. These minute-by-minute high-61 

resolution 4D data sets are then analyzed to correlate definitive cell-lineage identities with gene 62 

expression and morphological dynamics at single-cell and subcellular levels of detail. Our 63 

protocol is structured to enable modular implementation of each of the described steps and 64 

enhance studies on embryogenesis, gene expression, or neurodevelopment. 65 

 66 

INTRODUCTION:  67 

 68 

C. elegans stands out as the only organism in which every cell in the embryo can be observed 69 

throughout neurodevelopment. With the entire cell-lineage known and invariant1, and with the 70 

development of new tools that allow labeling and continuous imaging of single cells in embryos, 71 

biologists can now begin examining different steps in the development of the nematode nervous 72 

system from all angles – cell birth; migration and differentiation; neurite formation, targeted 73 

outgrowth and fasciculation; synapse formation; and tuning of functional circuits. Capturing 74 

neuronal outgrowth dynamics in the C. elegans embryo, by combining stably expressed reporters 75 

and fluorescence microscopy, is valuable to the scientific community. 76 

 77 

Developmental studies in C. elegans often leverage the invariant cell-lineage and cell-fate maps 78 

of this species to augment contextual understanding at the single-cell level within the intact 79 

organism1. Auto-lineaging analysis – using StarryNite2-4 and AceTree5-8 software – benefits from 80 

high contrast, high resolution images of fluorescent nuclei. To work optimally, 81 

StarryNite/AceTree also depends upon predictable constrained orientation of imaged embryos 82 

during development. Confocal microscopy, done in C. elegans embryos compressed between two 83 

coverslips, has been the standard auto-lineaging microscopy method for more than a decade 84 

because it provides both high contrast/high resolution and a predictable constrained orientation 85 

of the embryo7,8. We previously described the construction and use of a novel light-sheet-based 86 

dual-view inverted selective plane illumination microscope (diSPIM) for live sample imaging such 87 



   

as C. elegans embryogenesis9-13. Light-sheet microscopy, in general, provides low phototoxicity, 88 

high speed, and long-term imaging of live 3D specimens14,15. The diSPIM method, specifically, 89 

produces four-dimensional (4D) images with nearly isotropic spatial resolution of approximately 90 

330 nm9. 91 

 92 

Compared with confocal microscopy, diSPIM offers higher signal-to-noise and speed, more 93 

isotropic spatial resolution, and is more suitable for long-term in vivo imaging16. We therefore 94 

worked to adapt diSPIM data for input into StarryNite/AceTree and investigated whether this 95 

would enhance the lineaging analyses. A major hurdle is that diSPIM specimens cannot be easily 96 

constrained by eggshell-compression to adopt expected orientations for StarryNite/ AceTree. 97 

Random orientation of cell positions in the volume being analyzed degrades the accuracy of auto-98 

lineaging analysis.  99 

 100 

We therefore employed CytoSHOW, a viewer-guided user interface which allows users to select 101 

precise 3D orientation of embryos during pre-processing of diSPIM images, yielding image data 102 

that is both quality-optimized and context-aware for input into StarryNite/AceTree. Upon user-103 

selection of imaged embryos, CytoSHOW orchestrates an automated data processing pipeline. 104 

Cropped and background-subtracted embryo images are saved within TIFF stack files for each 105 

position, timepoint and view. CytoSHOW then iteratively calls the program SpimFusion to co-106 

register and jointly deconvolve the two pre-processed views, using the Richardson-Lucy17,18 107 

algorithm to yield isotropic high-resolution volumetric images. A diSPIM-specific set of 108 

parameters has been optimized for StarryNite to govern its behavior during image-segmentation 109 

and nucleus-tracking in isotropically fused images. Fused images and lineaging results are then 110 

edited using AceTree, which allows users to identify and fix any errors in the auto-lineage trace 111 

generated by StarryNite. AceTree can also can present lineage-tree and 3D modeled renderings 112 

of tracked nuclei in the embryo. We find that auto-lineaging speed and accuracy are markedly 113 

enhanced using isotropically fused images, when compared to raw images from either SPIM 114 

camera. Our protocol, while optimized for the C. elegans application described here, could be 115 

generally adapted for auto-lineaging of diSPIM data produced for other species or specimens. If 116 

this is the intended use of the protocol, please note that additional tuning of the StarryNite 117 

parameters will likely be required for new specimens, as described3,4.  118 

 119 

Successful implementation of this protocol results in images with 4D-isotropic resolution and 120 

enables biologists to trace cell lineages, while simultaneously identifying and analyzing neurons 121 

in the developing C. elegans embryo. Moreover, by merging several post-processing algorithms 122 

– with hardware acceleration being the most time-consuming of these – we can now analyze 123 

both fine subcellular details and the cell-lineages and cell-fates of live embryos in essentially real 124 

time. This new protocol allows precise, informed manipulation and observation of cell behavior 125 

during probative studies of differentiation and morphogenesis in vivo. In this manuscript, we 126 

present a detailed explanation of the improved protocols we have developed for lineaging and 127 

cell tracking in developing C. elegans embryos, to enhance studies of embryogenesis, gene 128 

expression or neurodevelopment. 129 

 130 

PROTOCOL:  131 



   

 132 

1. Assembling the diSPIM steel imaging chamber with poly-L-lysine coated coverslip 133 

 134 

NOTE: The steps below are all required to optimize and automate lineage analysis of nematode 135 

embryos by StarryNite/AceTree. Several options (indicated by as such) may be omitted for 136 

experiments that do require tracing of C. elegans cell lineages. 137 

 138 

1.1. Draw a small rectangle (2mm x 5mm) in the center of a clean rectangular coverslip (no. 1.5, 139 

24 mm x 50 mm) with a sharpie (or similar pen).  140 

 141 

1.2. Flip the coverslip over to the unmarked side and place 10 μL of poly-L-lysine (cat. no. P1524) 142 

over the marked rectangle.  143 

 144 

NOTE: Make a working concentration of 1 mg/mL poly-L-lysine dissolved in filtered water (or 145 

equivalent). For long-term storage, prepare 5–10 mL aliquots and store at −20 °C. Once thawed, 146 

the aliquots can be stored at room temperature (23 °C) for 3–4 weeks. 147 

 148 

1.3. Allow the poly-L-lysine to coat the coverslip for 5 minutes (Figure 1A). Poly-L-lysine is used 149 

for coating glass cover slips where the embryos will be mounted, allowing the embryo eggshell 150 

to stick firmly to the coverslip, even when the objectives are immersed in the imaging medium.  151 

 152 

1.4. Place the poly-L-lysine coated coverslip in the bottom half of the steel imaging chamber.  153 

 154 

1.5. Place the top half of the steel imaging chamber onto the bottom half with the coverslip and 155 

tighten with the four screws associated with the chamber. Check visually from the side to make 156 

sure the top half is evenly seated in the bottom half (Figure 1B). 157 

 158 

1.6. Fill the chamber with 7–8 mL of M9 buffer19, an isotonic buffer which helps prevent early 159 

stage embryos from succumbing to abnormal osmotic pressure. 1-cell, and even 2-cell embryos 160 

are osmotically sensitive and can develop abnormally if not in this isotonic buffer. Embryos also 161 

tend to arrest at the 3-fold stage if M9 is substituted with water.  162 

 163 

2. Preparing C. elegans embryo samples for mounting 164 

 165 

NOTE: Approximately 18 hours prior to imaging, five young (1 day since final molt) adults and ten 166 

larval stage 4 (L4) C. elegans are picked to a nematode growth medium (NGM) agar plate seeded 167 

with E. coli strain OP50. Platinum wire picks are used to move larvae and young adult C. elegans 168 

without harming the animal19. 169 

 170 

2.1. Prepare a 1% methyl cellulose (cat. no. H7509-25G) solution in M9 buffer.  171 

 172 

NOTE: Methyl cellulose must be stirred in warm M9 until it is dissolved. Once prepared, this 173 

solution can be stored at room temperature.  174 

 175 



   

2.2. Add 500 µL of 1% methyl cellulose-in-M9 solution into the depression of a concave 176 

microscope slide. This viscous buffer will be used in two occasions: 1) when harvesting early 177 

embryos by dissection of adult worms and 2) when washing late-stage embryos picked directly 178 

from an NGM plate.  179 

 180 

NOTE: Methyl cellulose is used to prevent embryos from sticking to the microscope slide.  181 

 182 

2.3. For imaging late stage embryos, pick laid C. elegans embryos (preferably from an NGM plate 183 

with young adults present) by using an eyelash pick, and move the embryos to the 1% methyl 184 

cellulose on the concave microscope slide. The eyelash pick helps reduce force and thus minimize 185 

stress or damage to the embryos during handling. The procedure to make an eyelash pick is 186 

covered by Hart20.  187 

 188 

2.4. With a second eyelash pick (in the opposite hand), gently tap both eyelashes together to 189 

suspend the embryos in the methyl cellulose.  190 

 191 

2.5. Optional: If planning to lineage embryonic cells with StarryNite, one must mount 1-cell to 4-192 

cell embryos. To do so, first select young adults from an NGM plate and move them into the M9-193 

methyl cellulose solution on the concave microscope slide by using a platinum wire pick.  194 

 195 

2.6. Optional: With the sharpened tips of hypodermic needles (no. 18G x 1 ½), slice the animal 196 

transversely at the mid body to release 1-cell to 4-cell embryos.  197 

 198 

3. The Mouth Pipette: Assembling aspirator tube with microcapillary pipette 199 

 200 

NOTE: We use an aspirator tube with a hand pulled microcapillary pipette inserted into the 201 

rubber gasket of the tube. This allows us to transfer embryos from the dissection slide to the 202 

Poly-L-lysine-coated surface in the buffer-filled imaging chamber.  203 

 204 

3.1. Manually pull the microcapillary pipette over an open flame to create two halves with 205 

stretched tips.  206 

 207 

3.2. Take one half of the microcapillary pipette and insert the blunt end into the rubber gasket 208 

of the aspirator tube (Figure 1C). Set the other half of microcapillary pipette aside for use later 209 

(if needed). 210 

 211 

3.3. With the assembled aspirator tube fitted with microcapillary pipette, gently break the tip of 212 

the microcapillary pipette and create an opening that will fit about 1–2 two embryos (from here 213 

on this instrument is called a “mouth pipette"). 214 

 215 

4. Mounting C. elegans embryos on Poly-L-lysine coated coverslip 216 

 217 



   

4.1. With the aspirator mouthpiece held gently between the teeth, pre-fill the microcapillary 218 

pipette with 10–15 µL of M9 Buffer and then gently suck several embryos from the concave slide 219 

into the capillary. 220 

 221 

4.2. Transfer the embryos to the steel imaging chamber filled with M9 Buffer, positioning the 222 

capillary tip so that embryos will fall into the central rectangle of the coverslip.  223 

 224 

4.3. Avoiding injury to the embryos, gently move them with an eyelash pick or use the mouth 225 

pipette to position the embryos vertically, to orient the embryos so that the long axis of the 226 

embryo is perpendicular to the long axis of the coverslip (Figure 1B inset, bottom panel).  227 

 228 

NOTE: Positioning the embryo in this orientation minimizes the number of slices to image, 229 

thereby reducing light dosage and data processing time while improving acquisition speed. 230 

 231 

4.4. Place the steel imaging chamber into the sample holder on microscope stage (Figure 1D). 232 

 233 

5. Assembly, software setup and laser optimization for embryonic imaging using the diSPIM  234 

 235 

5.1. See step-by-step instructions on how to assemble the entire fiber-coupled diSPIM from 236 

commercially available parts in Kumar et al.10,11 and at http://www.dispim.org. A video-protocol 237 

of how to assemble the diSPIM is also available on the ASI website (http://www.asiimaging.com). 238 

 239 

NOTE: Instrument setup for this protocol is identical to Kumar et al.10,11 diSPIM, which makes use 240 

of 40x 0.8NA water immersion lenses for imaging. The only difference between the setup in this 241 

protocol and Kumar et al.10,11 is the addition of a dichroic mirror (splitting at 560 nm) and red and 242 

green bandpass filters inside an imaging splitting device (model A12801-01) installed on both 243 

diSPIM imaging arms. The addition of image splitting optics allows simultaneous capture of 244 

images from two distinct fluorophores – excited by 561 nm and 488 nm lasers – by separating 245 

the emission bands onto two halves of the same camera chip.  246 

 247 

5.2. After instrument assembly, check the optical alignment of the diSPIM before imaging.  248 

 249 

NOTE: To properly align the diSPIM see https://youtu.be/qnOrg30NNuE, and for hardware 250 

information, http://dispim.org/hardware/objectives and http://www.asiimaging.com. 251 

 252 

5.3. Use the open-source platform Micro-Manager (https://micro-manager.org/)21, which has 253 

been optimized for operating Light Sheet Microscopes for high-throughput cellular imaging22. We 254 

recommend use of the ASI diSPIM plugin for multi-position acquisition, which allows 255 

simultaneous imaging of up to 30 embryos as described23.  256 

 257 

5.4. With Micro-Manager open, set laser intensities to ~179 µW (0.5) for 488 nm and ~79 µW 258 

(0.25) for 561 nm (Figure 2A, red rectangle). 259 

 260 

http://www.dispim.org/
http://www.asiimaging.com/
https://youtu.be/qnOrg30NNuE
http://dispim.org/hardware/objectives
http://www.asiimaging.com/
https://micro-manager.org/)
https://micro-manager.org/)


   

NOTE: These are recommended settings for long-term imaging of C. elegans embryos using 1-261 

minute intervals. During long-term dual-color imaging, the 561 nm laser is used to image nuclei 262 

(mCherry::Histone) until embryos are at bean stage, at which point the 488 nm laser is then turn 263 

on to also image the GFP-labeled neurons. These imaging conditions are optimized for minimizing 264 

phototoxicity and ensuring survival and hatching of the embryos while enabling prolonged (12–265 

14 hours) continuous acquisition of neurodevelopmental and lineaging data. 266 

 267 

5.5. In Micro-Manager, choose menu Plugins > Device Control > ASI diSPIM to open the ASI 268 

diSPIM window (Figure 2B). Choose the Acquisition Tab. In this tab's Data Saving Settings section 269 

(green rectangle), Volume Settings section (blue square), and Slice Settings section (orange 270 

square), ensure that each parameter is set as shown in Figure 2B. 271 

 272 

NOTE: Our image analysis software CytoSHOW is adapted to work with other optional output 273 

data formats such as bulk-concatenated OME-TIFF file series and TIFF-stack file series created 274 

post-acquisition through use of an export function built into Micro-Manager. Typically, the single-275 

time-point-stack collated OME-TIFF file data format is used because it allows real-time viewing 276 

and processing of image volume as soon as the raw data are acquired. 277 

 278 

6. Optimized autofocus parameters for long-term imaging of C. elegans embryos 279 

 280 

6.1. Set Micro-Manager autofocus parameters to the settings optimized for long-term lineage-281 

quality diSPIM-imaging of C. elegans embryos. In the ASI diSPIM window, click the Autofocus Tab 282 

(Figure 2C). In the General Autofocus Options section (black square) specify parameters precisely 283 

as shown. Note that the Autofocus channel (red square) should specify your nuclear channel 284 

fluorescence channel in lineaging experiments.  285 

 286 

NOTE: If the max offset is greater than 5 µm, images tend to drift out of focus.  287 

 288 

6.2. Click, Plugins > Acquisition Tools > Pattern Overlay. 289 

 290 

6.3. In the Pattern Overlay window, click Show Grid. 291 

 292 

6.4. In the ASI diSPIM window, click the Navigation tab. 293 

 294 

6.5. Click check boxes for Beam and Sheet of Path A or B then click Live. Image acquisition begins. 295 

A Live view window opens. Select the auto-focus analysis region of the embryo by drawing a box 296 

around the embryo on the selected channel from 6.1.  297 

 298 

NOTE: We typically capture 420 time points for 10 embryos per imaging session. The raw data 299 

per image session are typically 1.7TB, while deconvolved and StarryNite-processed data are 1.4TB 300 

(see Steps 9 and 10). We recommend using large-capacity HDD (18TB on our current system) for 301 

image acquisition, and cloud platforms for image storage. 302 

 303 



   

6.7. Click Start Acquisition in the "Acquisition Tab to commence long-term multi-dimensional 304 

image capture (Figure 2B).  305 

 306 

7. Opening raw Micro-Manager images in CytoSHOW 307 

 308 

7.1. Download the software bundle from http://dispimlineage.wormguides.org. 309 

 310 

NOTE: The software bundle will be downloaded as a .zip file and will need to be extracted to the 311 

“C:\” directory before use. Further details for installation are given at 312 

http://dispimlineage.wormguides.org/diSPIMlineaging_InstallationInstructions.htm .  313 

 314 

7.2. Double-click the file C:\CytoSHOWextrasForC\CytoSHOW_APP.jnlp to begin running 315 

CytoSHOW.  316 

 317 

7.3. Choose menu File > New > diSPIM Monitor (Micro-Manager). Locate the root data set folder 318 

where acquisition timepoint folders were saved. Select any timepoint folder and click Open. 319 

Multidimensional navigation windows (called diSPIM monitor windows) are opened 320 

automatically for both SPIMA and SPIMB (Figure 3A). 321 

 322 

NOTE: These windows will monitor the root data folder for newly saved raw timepoint stacks (in 323 

the event that a specimen is still being recorded). After each new timepoint is acquired, each of 324 

the windows monitoring the distinct SPIM arms and sample positions will refresh to display the 325 

entire multichannel 4D dataset for each embryo. 326 

 327 

8. Generating Max projection images with CytoSHOW 328 

 329 

Even before deconvolution, the raw data can be quickly processed to appraise the specimen's 330 

global features.  331 

 332 

8.1. Click the Z-MIP button on the left side panel of the image window (Figure 3A, red rectangle) 333 

to make maximum intensity projections through the full depth and full-time course of a given 334 

position or SPIM arm. A Z-projection hyperstack window will appear. 335 

 336 

8.2. In the Z-projection hyperstack window, set projection type to Max intensity. Specify which 337 

channels, slices, and time-point frames to process based on user preference.  338 

 339 

8.3. Click OK when completed.  340 

 341 

8.4. Select the folder location to save the Max intensity outputs from the file dialogue window, 342 

and then click OK. Allow some time (15–20 minutes, depending on size of dataset and processing 343 

power of the computer) for CytoSHOW to generate projection images. 344 

 345 

9. Analyzing cell lineages in isotropic high-resolution volumetric data  346 

 347 

http://dispimlineage.wormguides.org/
http://dispimlineage.wormguides.org/diSPIMlineaging_InstallationInstructions.htm


   

9.1. Optional: With the raw data open via diSPIM monitor in CytoSHOW, select the Polygon 348 

selection tool (Figure 3A, black arrows) and click just outside the embryo’s anterior, posterior, 349 

dorsal and ventral edges (in that exact order) to generate a “bowtie" pattern over the embryo. 350 

Do for both views (SPIM-A and SPIM-B, Figure 3A).  351 

 352 

NOTE: This selection specifies the elliptical region of interest (ROI) in which the embryo is 353 

centered and records the anterior-posterior axis of the embryo. The bowtie pattern cues 354 

CytoSHOW that the user plans to further specify a precise rotation of the final isotropically fused 355 

volumes into an orientation that is optimal for lineaging analyses by StarryNite/AceTree. In cases 356 

where StarryNite lineaging is not part of the experimental plan, other selection tools and shapes 357 

may be chosen to set the ROI for image processing. 358 

 359 

9.2. If multiple embryos were simultaneously imaged by using the multi-position acquisition 360 

option, open and perform Step 9.1 for all embryos. This will allow parallel execution of future 361 

steps for all embryos in one session. Close the SIMA and SPIMB windows for any embryos you do 362 

not wish to process. 363 

  364 

9.3. Click the diSPIM button on the left side panel of diSPIM monitor window (Figure 3A, 365 

highlighted in yellow). This reveals a subpanel of controls specific to diSPIM processing. 366 

 367 

9.4. Align green and red channels for each SPIM arm. Because emission channel splitters are used 368 

to capture distinct red and green images simultaneously on the same camera, it is important to 369 

visually align the exact pixel registration of these two physically adjacent image fields when they 370 

are overlaid. Reuse of the same alignment adjustments is typically feasible over many 371 

consecutive imaging sessions, but should be checked (as in Steps 9.4.1–9.4.5). 372 

 373 

9.4.1. Starting with the SPIMA panel, select the red channel by moving the CM scroll bar to the 374 

left (Figure 3A, orange arrow, left panel).  375 

 376 

9.4.2. Using the x-, y-, and z-adjusters (Figure 3A, orange square), shift the red channel to match 377 

the green.  378 

 379 

9.4.3. Click diSPIM button (Figure 3A, highlighted in yellow), to close the subpanel and trigger 380 

propagation of the same shifts to all other Position windows. 381 

 382 

9.4.4. Confirm that correct alignment propagated to other frames and time points by moving the 383 

“z” scroll bar (Figure 3A, blue arrow, left panel) and/or “t” scroll bar (Figure 3A, green arrow, left 384 

panel). If multi-position acquisition was performed and several embryos were imaged (Step 5.3), 385 

the alignment should have also propagated to those embryos. Confirm by also examining the 386 

numbers for x-, y-, and z-adjusters (Figure 3A, orange square, which should be the same for the 387 

SPIMA panel of all embryos). 388 

 389 

9.4.5. Repeat Steps 9.4.1–9.4.4 for the SPIMB diSPIM monitor window (Figure 3A, right panel). 390 

 391 



   

9.5. Click the “diSPIM” button and then the “Fuse” button (Figure 3A, blue rectangle) to open a 392 

dialog box called “Deconvolve/Fuse diSPIM Raw Data Volumes” (Figure 3B). Set parameters as 393 

shown in Figure 3B. These parameters are briefly addressed in the following substeps: 394 

 395 

9.5.1. Set Key registration on Channel 1 (488 nm laser) or 2 (561 nm laser). Select the channel 396 

with denser or more ubiquitous signal. For lineaging experiments always select the channel used 397 

to image the ubiquitous nuclear histone fluorescence. 398 

 399 

9.5.2. Set input volumes relative orientation to +1 or -1. The correct orientation index depends 400 

on a specific diSPIM’s camera placements (Figure 4).  401 

 402 

NOTE: If uncertain, test each option by duplicating a single timepoint from both SPIM A and B 403 

diSPIM monitor window, following steps 9.1–9.12 and arbitrarily choosing an input volumes 404 

relative orientation to test. Incorrect orientations will yield blurry images with artifacts, while 405 

correct orientations will yield clear images. The input volumes relative orientation value that 406 

yields the clear image can then be reused for all future data from the given diSPIM instrument. 407 

 408 

9.5.3. Choose whether the fused volume should be oriented the same as the A or B input volume 409 

(based on user preference).  410 

 411 

9.5.4. Select "Fresh registration for every volume". This option controls how SpimFusion 412 

calculates registration matrices for each volume pair at each timepoint. The “Fresh” option allows 413 

the algorithm to optimize registration adaptively at each timepoint. 414 

 415 

9.5.5. Set the number of deconvolution iterations to 10. This number tends to reliably yield the 416 

desired high resolution in a time-efficient manner.  417 

 418 

9.5.6. Optional: If auto-lineaging is desired (highly recommended), check Auto-launch StarryNite 419 

lineaging of Fused Volumes. This option will launch StarryNite automatically to segment and 420 

track cells in the imaged volumes produced by SpimFusion.  421 

 422 

9.5.7. Optional: For highest accuracy in automated lineaging, it is best to reposition the 423 

isotropically fused embryo volumes into the canonical "ADL" (Anterior[x-west], Dorsal[y-north], 424 

Left[z-near]) orientation. Select the Define volume output orientation in preview option to 425 

indicate this choice. CytoSHOW will respond by processing an initial pair of isotropically fused 426 

volumes, allowing the user to closely observe and specify the rotations needed to achieve ADL 427 

registration.  428 

 429 

9.5.8. Click Yes once all parameters are selected. 430 

 431 

9.6. Specify the Output directory in which to save the processed files. Click OK.  432 

 433 

9.7. Optional: If the Define volume output orientation in preview option was selected, set the t 434 

scroll bar (Figure 3A, green arrow, left panel) in the SPIM-A window to the early timepoint at 435 



   

which ABa and ABp cells have reached metaphase. Set the t scroll bar in the SPIM-B window to 436 

the later comma stage of development. This will aid in specifying ADL orientation.  437 

 438 

9.8. Optional: Click OK when ready. If the previewing option in 9.5.7 above was selected, only 439 

two preview volumes will be isotropically fused for the timepoints indicated by the t-sliders of 440 

the SPIM-A and SPIM-B image windows. These two preview timepoints can be used to specify 441 

precise realignment of output embryo volumes to the ADL orientation, as explained below.  442 

 443 

9.8.1. Locate the newly displayed 3DProjY_Decon-Fuse_.... window. Move the t scroll bar to time 444 

point 2 of this preview window. Move the Z slider until the view directly down the embryo's long 445 

axis is shown. 446 

 447 

9.8.2. Move the t scroll bar back to time point 1 of the 3DProjY_Decon-Fuse_.... window. Choose 448 

the line-selection tool and draw a line selection from the EMS cell (ventral-most round nucleus) 449 

through the plane of the AB-cell metaphase plates. 450 

 451 

9.8.3. Click the orange diSPIM Preview button on the 3DProjY_Decon-Fuse_.... window. The fine 452 

adjustments to the orientation of the previewed imaged volume will be saved for use in 453 

processing the full dataset.  454 

 455 

9.9. Optional: The Deconvolve/Fuse diSPIM Raw Data Volumes dialog will reappear, just as in 456 

step 9.5 above. Click Yes without choosing the Define volume output orientation in preview 457 

option. Specify the Output Folder for the full data processing run.  458 

 459 

9.10. Set the t scroll bars (Figure 3A, green arrow, left panel) of the diSPIM monitor windows to 460 

the starting timepoint (SPIMA) and ending timepoint (SPIMB) of the full span of images to 461 

process. Then click Ok. 462 

 463 

9.11. As SpimFusion progresses, CytoSHOW opens and refreshes a multidimensional window 464 

showing the sliced-4D isotropic fused volume for each embryo, as well as two windows with 465 

rotating-4D max-intensity projections of the isotropic volume. During this time, do not disrupt or 466 

close any CytoSHOW window until isotropic fusion and lineage tracking are complete.  467 

 468 

9.12. Optional: Note that once the StarryNite splash screen has appeared and later disappeared, 469 

the full data-processing pipeline has been completed. This window must not be closed during 470 

processing or StarryNite will be interrupted.  471 

 472 

NOTE: If a processing job is interrupted at any step for any reason, it can be resumed and 473 

completed. Quit and relaunch CytoSHOW, start a File > New > diSPIM Monitor (Micro-Manager) 474 

from the same raw data directory as before, align the image channels for each SPIM-A/B volume, 475 

click Fuse, specify the same SpimFusion processing parameters, indicate the same Output folder 476 

as before, and select again the beginning and end points for the full time course. Processing will 477 

then resume automatically from where it was interrupted. 478 

 479 



   

10. Opening StarryNite lineage trace series in AceTree (optional) 480 

 481 

10.1. Open the customized version of “AceTree_16BitCompat.jar” provided.  482 

 483 

10.2. Choose menu the File > Open configure file. Locate your Output directory previously 484 

indicated to CytoSHOW. Open the Decon_Fuse_..._Pos[n] subfolder for embryo [n]. Select 485 

aaa_edited.xml and Open.  486 

 487 

10.3. Use the AceTree menu Edit > Edit tools to open the Edit Track and Adjust or Delete Cells 488 

windows.  489 

 490 

10.4. Click the half-shaded circle Figure 5B, red square to adjust the Red and Green intensities. 491 

 492 

10.5. Proceed with lineage visualization and editing as previously described5,6,8 (manuscripts are 493 

also included in our download bundle).  494 

 495 

REPRESENTATIVE RESULTS:  496 

 497 

We first validated the viability of embryos imaged using the protocol's parameters for diSPIM 498 

acquisition (sections 1–6). Ten embryos were simultaneously imaged at 20 °C, one 499 

volume/embryo/minute, from the 2-cell stage to the 2-fold stage (7.5 hours, 451 500 

volumes/embryo). To monitor cell divisions throughout embryogenesis, we used strain BV514, 501 

which ubiquitously expresses the mCherry::Histone reporter constructs from the integrated 502 

transgene array ujIs11324. Figure 6 shows a timeline of this first half of embryonic development 503 

for one of the imaged embryos. Each image represents a single-view maximum-intensity 504 

projection (produced by steps 7–8) of the imaged embryo. We found that the optimized 505 

protocols did not induce any detectable phototoxicity to the embryos, as assessed by timing of 506 

cell divisions (not shown), time of hatching, and timing related to developmental milestones 507 

(Figure 6 and references1,25,26).  508 

 509 

We then applied the protocol to analyze outgrowth dynamics of single neurons in developing 510 

embryos. We imaged DCR7692 (olaex4655), a transgenic nematode strain that expresses GFP off 511 

the neuropeptide flp-19 promoter in a subset of unidentified cells (DACR2819, Pflp-19 512 

(3.6kb)::Syn21::GFP::CAAX::p10 3’UTR). Following the steps of the protocol outlined here, we 513 

determined that the unidentified cells correspond to motor neurons RMDDL and RMDDR, to the 514 

excretory canal cell, and to two muscle cells (Figure 7). We then examined and quantified the 515 

outgrowth dynamics of the RMDDL and RMDDR neurons. We observed that the RMDDL and 516 

RMDDR neurons are obliquely shaped as early as 360 minutes post fertilization, with the longer 517 

cellular axis representing the subsequent axis for neurite outgrowth (Figure 7 and Movie S1). 518 

Using the “simple neurite tracing” plugin in FIJI and applying it to 3D reconstructions of 519 

isotropically fused volumes, we then quantified the stereotypic outgrowth of the RMDDL and 520 

RMDDR neurites for six embryos. We determined that the outgrowth dynamics were stereotyped 521 

for RMDDL and RMDDR across embryos (herein called RMDDs). From 385–410 minutes post 522 

fertilization, the RMDDs neurites extended 6.0±0.5µm (mean ± SEM; n = 12 neurites) anterior of 523 



   

the cell bodies (Figure 7B,C,I). From 415-445 minutes post fertilization, both neurites extend 524 

dorsally into and around the presumptive nerve ring (asterisk in Figure 7D). On average, each 525 

RMDD neurite extended 11.0 ± 0.6 µm (mean ± SEM; n = 12 neurites) from the cell body before 526 

synchronously meeting its contralateral counterpart at the apex of the ring (Figure 7I). 527 

Importantly, our representative results demonstrate that we are able to examine, compare and 528 

quantify neuronal developmental features for single identifiable cells by using our integrated 529 

protocol (Figure 7 and Figure 8). 530 

 531 

FIGURE AND TABLE LEGENDS:  532 

 533 

Figure 1: diSPIM sample mounting setup. (A) Preparation of coverslip with Poly-L-lysine. In the 534 

inset, 10 µL of Poly-L lysine was used to coat the coverslip for 5 minutes. Poly-L-lysine allows the 535 

embryo eggshell to stick firmly to the coverslip in the rectangle. (B) Schematic of the steel imaging 536 

chamber and the assembled chamber. In the inset, representative embryos are oriented with the 537 

anterior-posterior axis perpendicular to the long axis on the coverslip. (C) Assembled aspirator 538 

tube with microcapillary pipette. (D) Steel imaging chamber mounted in sample holder under 539 

diSPIM 40x objectives. 540 

 541 

Figure 2: Long-term diSPIM imaging setup in Micro-Manager. (A) Recommended diSPIM laser 542 

power parameters (red rectangle) optimized for prolonged imaging while reducing phototoxicity 543 

(as assessed by higher hatching rate of C. elegans embryos). Set 561 nm laser to 79 µW (0.25) 544 

and 488 nm laser to 179 µW (0.5). Note that exact calibration of software settings to laser power 545 

varies among diSPIM installations. It is recommended that users measure and calibrate the laser 546 

power in order to achieve 79 µW (561 nm) and 179 µW (488 nm) laser power. (B) diSPIM 547 

parameters for data saving (green rectangle), volume settings (blue square), and slice settings 548 

(orange square). (C) diSPIM autofocus parameters for long-term imaging of C. elegans 549 

embryogenesis (see steps 6.1–6.6). 550 

 551 

Figure 3: Image visualization and data-processing setup using CytoSHOW. (A) Raw diSPIM 552 

images opened by CytoSHOW. CytoSHOW is able to open images captured by both camera paths 553 

(SPIM A and B). These raw images are opened in multidimensional windows called diSPIM 554 

monitor. In diSPIM monitor, a “bowtie pattern” is generated to select the embryo’s anterior, 555 

posterior, dorsal and ventral edges (see step 9.1). Bow-tie selections indicate embryo orientation 556 

for deconvolution and StarryNite-assisted lineaging tracing. (B) Optimized parameters used to 557 

generate isotropic images. In the Deconvolved while acquiring window, set the parameters 558 

specified in steps 9.5.1–9.5.8. 559 

 560 

Figure 4: diSPIM camera configuration. (A) Photograph of diSPIM camera placements and 561 

orientations. (B) Depiction of +90-degree rotations of SPIM A to match SPIM B images collected. 562 

(C) Input volumes relative to orientation index +1 based on our diSPIM’s camera configuration 563 

(see step 9.5.2). We rotate SPIM A image(s) +90 degrees around Y-Axis before registration to 564 

match SPIM B image(s). Scale bars = 10 µm. Images are representative single-view, maximum-565 

intensity projections and deconvolution images of 1.5-fold embryo with labeled nuclei (561-nm, 566 

red) and neurons (488-nm, green). 567 



   

 568 

Figure 5: Curation and editing C. elegans embryonic lineage in AceTree. (A) We use AceTree to 569 

edit StarryNite’s lineage traces (see references5,6,8; manuscripts are also included in our 570 

download bundle). AceTree will display C. elegans systematic names for each nucleus (green 571 

rectangle) upon completion of steps 10.1–10.2. This window (A) provides information (black 572 

rectangle) about each cell in the lineage trace (ABa, highlighted in blue) that help guide users 573 

when tracking and editing the lineage traces. It is recommended that users verify and compare 574 

lineaged cells and their positions to the C. elegans embryonic cell lineage previously reported by 575 

Sulston et al.1 In addition, if users are interested in locating specific cells in the deconvolved data 576 

series (see below, B) enter the C. elegans systematic name in the search bar (orange rectangle). 577 

(B) The user’s deconvolved data series also opens automatically upon completion of steps 10.1-578 

10.2. Shown here an isotropically fused image of a four-cell stage embryo with nuclei labeled in 579 

red. During tracking of a nuclei, users should change the intensity of the image (red square) and 580 

navigate through time and z using the arrow keys on their keyboard (time-left/right, z-up/down). 581 

(C) 3D cartoon of the timepoint in (B) with certain functionalities (purple rectangle) that enables 582 

rotatable 3D-visualization. For an overview of AceTree and its 3D functionality, see 583 

references5,6,8. 584 

 585 

Figure 6: Timed developmental dynamics of C. elegans embryos on the diSPIM. Top panel, 586 

diSPIM images showing the first half of embryonic development for one of the imaged embryos 587 

(Strain BV514 ujIs11324). Embryos were imaged continuously, every minute for 7.5 hours (at 20 588 

°C). The first two images of top panel represent 4- and 8-cell embryos with nuclei (red) and 589 

positions of polar bodies (dense red spheres, marked with blue asterisks). Each image represents 590 

a single-view maximum-intensity projection of the imaged embryo. Scale bars = 10 µm. The 591 

timeline (horizontal bar) represents minutes post fertilization (m.p.f.) of the development of C. 592 

elegans embryos. We validated that our protocol's parameters for diSPIM acquisition did not 593 

induce any detectable phototoxicity to the imaged embryos as assessed by viability, timing of cell 594 

divisions, timing of hatching and timing of developmental milestones (see references1,25,26). We 595 

note that the timing of developmental milestones was reproducible across embryos with our 596 

imaging parameters (SEM ± 8.174 minutes for 6.4 hour long imaging sessions; n = 10). 597 

 598 

Figure 7. Cellular identification and single cell characterization of neurite outgrowth dynamics 599 

in developing C. elegans embryos. Dual-color imaging of a strain made by crossing BV514 600 

ujIs11324 (for lineaging) and DCR7692 (olaex4655), a transgenic nematode strain that expresses 601 

GFP off the neuropeptide flp-19 promoter in a subset of unidentified cells. (A–H) Following the 602 

steps of the protocol outlined here, we determined that the unidentified cells correspond to 603 

motor neurons RMDDL and RMDDR (yellow arrows), to the excretory canal cell (blue arrows), 604 

and to two muscle cells (white arrows). (I) Quantification of the outgrowth dynamics of the 605 

RMDDL and RMDDR neurons by using FIJI plugin “simple neurite tracing” and applying it to 3D 606 

reconstructions of isotropically fused volumes. Note how both RMDDL and RMDDR show 607 

stereotypic outgrowth dynamics, each extending synchronously for a total length of 11.0±0.6µm 608 

(mean ± SEM; n = 12 neurites) and meeting at the dorsal apex of nerve ring (see also Movie S1).  609 

 610 



   

Figure 8: Examination of Isotropic diSPIM images of neuronal morphologies in C. elegans 611 

embryos. Isotropic visualization of AVHL and AVHR neurons (yellow arrows). Using the diSPIM, 612 

neuronal morphologies can be captured yielding four-dimensional (4D) images with isotropic 613 

spatial resolution of approximately 330 nm. The diSPIM allows users to virtually rotate image 614 

volumes with identical resolution in all direction. Images in A–D are maximum-intensity 615 

projections of the same isotropically fused diSPIM image volume from distinct rotations around 616 

the embryo's long axis. Scale bars = 5 µm. 617 

 618 

Supplementary Movie S1: C. elegans embryo developing from 280 to 434 minutes post 619 

fertilization. Isotropic movie of strain DCR7692 (olaex4655) expressing ujIs113 ubiquitously with 620 

DACR2819 sparsely labeling RMDD neurites (Figure 7A–D, yellow arrows). DACR2819 also labels 621 

two muscle cells (Figure 7A–D, white arrows) and excretory canal cell (Figure 7A–D, blue arrow) 622 

during embryonic development (Figure 7A–D). Scale bars = 10 µm.  623 

 624 

DISCUSSION: 625 

 626 

C. elegans stands out as the only organism with the final positions and connectivity of each adult 627 

neuron known27. However, the developmental dynamics leading to organization of the working 628 

circuits and networks that makes up the C. elegans connectome remain unknown. Based on 629 

opportunities emerging from advances in light microscopy, we can now capture and analyze cell 630 

positions, morphogenesis, and neurogenesis throughout C. elegans embryonic development.  631 

 632 

The procedure that we have described and that we routinely use in the lab yields 4D-isotropic 633 

images of labeled neurons and nuclei for cell-lineaging in C. elegans embryos. More importantly, 634 

we have optimized long-term imaging conditions with the diSPIM and coupled semi-automated 635 

lineaging capabilities with high-resolution images to improve the speed and precision of 636 

analyzing C. elegans embryogenesis. This integrated protocol will enable users to visualize and 637 

identify cells and quantitate three-dimensional features such as neurite migration and axon 638 

fasciculation through onset of early twitching. This procedure can be readily adapted into any 639 

facility with an ASI diSPIM system, and we recommend this system specifically for this protocol. 640 

Other SPIM formulations offered commercially may differ from the ASI configuration in the 641 

sample chamber and optical properties. However, data exported from other platforms can also 642 

be put through our data pipeline. Therefore, appraisal of their value in lineaging, a demanding 643 

test of image quality and instrument stability, is feasible. Even though we actively use the diSPIM 644 

to regularly image other specimens (such as drosophila and zebrafish embryos), the described 645 

and comprehensive lineaging analysis of embryos is still currently limited to the nematode 646 

species. For larger or thick samples, we opt to use stage-scanning approaches, which scan the 647 

samples through a stationary light sheet. Kumar et al. have previously demonstrated this 648 

improved diSPIM sectioning to yield high quality images from thick samples without additional 649 

modifications to the diSPIM10.  650 

 651 

The critical steps within the protocol include mounting C. elegans embryos on the poly-L-lysine 652 

coated coverslip, data acquisition, and data processing. Harvesting and mounting C. elegans 653 

embryos on the glass coverslip can be challenging to inexperienced users, but here we provide a 654 



   

detailed protocol of key steps to facilitate learning. If long-term imaging is desired, we obtain 655 

best results harvesting four-cell or earlier embryos from 8–10 young adults28. Note that old adults 656 

are less desirable to harvest early stage embryos because they tend to contain older embryos in 657 

the uterus and unfertilized eggs. In regards to mounting embryos, problems such as blockage in 658 

the assembled aspirator (mouth pipette) or a too-large of an opening in the microcapillary pipette 659 

may prevent proper mounting and orientation of embryos. To prepare for optimal imaging, we 660 

perform pre-acquisition testing on early and late pre-twitching embryos to check the 661 

performance of the light sheets, cameras, objectives, and autofocus. We obtain best results when 662 

all of these operations are tested and yield high quality images during our pre-acquisition testing. 663 

This is particularly relevant for generating images with isotropic spatial resolution, for which raw 664 

images acquired from both views (objectives) must be of high-quality. After acquisition, the 665 

volumes acquired for each view are processed to yield isotropic images. It is important to use an 666 

appropriate graphics processing unit (GPU) card as described in this protocol (see below). This 667 

improves the processing speed at which the isotropically fused images are generated, shortening 668 

the time to data analyses. It is also imperative that users are running the latest version of 669 

CytoSHOW and are using the parameters provided with our download bundle for StarryNite auto-670 

lineaging. If users are interested in using auto-lineaging for other samples (e.g., zebrafish, 671 

drosophila etc.) then additional optimization to the parameters used in StarryNite will be 672 

required (see references3,4). 673 

 674 

Although our integrated protocol provides images and lineaging results in the pre-twitching 675 

embryo, users should be aware that automated lineaging in the post-twitching embryo is 676 

currently not feasible: nuclear positions changes on the order of seconds in the post-twitching 677 

embryo, too rapidly to allow lineage tracking. However, the diSPIM has indeed demonstrated a 678 

promising capability to capture neurodevelopmental events and track some cell positions in the 679 

post-twitching stages of embryogenesis23,29. If users are interested in examining the post-680 

twitching embryo, the diSPIM does provide the speed to obtain volumetric snapshots and track 681 

fine neurodevelopmental events, such as neurite outgrowth, in rapidly moving embryos.  682 

 683 

This protocol will be foundational for the cell-by-cell completion of the WormGUIDES atlas30, as 684 

it will provide an integrated approach with high resolution isotropic images to identify and 685 

capture 3D morphologies of labeled neurons during the first 430 minutes of embryogenesis. As 686 

it stands, the prototype WormGUIDES atlas provides nuclear positions of cells in the developing 687 

embryo and aims to capture the developmental dynamics of a subset of embryonic neurons. This 688 

protocol will be a key for the integration of additional developing neurons into the WormGUIDES 689 

atlas30.  690 

 691 

Our integrated protocol will also simplify exploring new gene expression profiles in the C. elegans 692 

embryo. In transgenic C. elegans, many cell-specific promoters spatially and temporally control 693 

transgene expression. While the expression patterns of most genes have been extensively 694 

characterized in the adult animal31-34, nearly all have yet to be characterized in the developing 695 

(especially late-stage) embryo. The C. elegans promoterome has been a useful resource to the 696 

worm community to drive cell-specific transgene expression, as well as determine whether gene 697 

function is cell-autonomous or non-autonomous. Capturing isotropic high-resolution and 698 



   

dynamic expression patterns of genes, and precisely identifying expressing cells via lineaging will 699 

be valuable to many in the scientific community.  700 

 701 

Embryogenesis comprises two intertwined major processes, cellular differentiation and tissue 702 

morphogenesis. A great deal is known about the mechanisms and molecules that define distinct 703 

cell types during the development of C. elegans. However, little is known about the mechanisms 704 

important for cell migration, cell adhesion, and cell shape in the C. elegans embryo. With the C. 705 

elegans invariant cell lineage known, our protocol lets us readily discern the catalogued 3D-706 

microanatomy of the embryo during morphogenesis at new levels of detail: e.g., axon 707 

fasciculation, synaptogenesis, and neuronal activity. Ardiel et al. have previously demonstrated 708 

the power of the diSPIM to capture calcium transients at the level of a single neurons in C. elegans 709 

embryos23. Many other aspects of developmental physiology are ripe for inquiry by these 710 

methods.  711 

 712 

Finally, this protocol is largely automated and systematically reduces the time it takes to generate 713 

deconvolution images and perform cell-lineaging via StarryNite and Acetree. The software 714 

strategies used in this protocol can be applied to many questions of biology far-flung from the 715 

very specific fields in which we have demonstrated them here.  716 

 717 

Details on software compatibility and download access  718 

 719 

Information on Micro-Manager and plugins for diSPIM imaging are available at 720 

http://dispim.org/software/micro-manager and https://micro-721 

manager.org/wiki/ASIdiSPIM_Plugin. 722 

 723 

The data-processing pipeline currently requires a Windows operating system. We have bundled 724 

a single archive file to simplify installation of all required data-processing programs and support 725 

files. It is available for download at http://dispimlineage.wormguides.org. 726 

 727 

CytoSHOW (http://run.cytoshow.org/) is based on the widely used and open source image 728 

analysis platform, ImageJ (v1). Java must be installed and up-to-date on the computer to use 729 

CytoSHOW, and updates to CytoSHOW are deployed automatically via Java Web Start. Many 730 

ImageJ-based functions of CytoSHOW are as described and illustrated at 731 

https://imagej.nih.gov/ij/docs/examples/index.html. CytoSHOW has been customized to display 732 

multidimensional raw data from the ASI diSPIM, as well as other imaging software that creates 733 

TIFF output. In principle, other multi-view SPIM imaging systems could be supported by minor 734 

modifications of CytoSHOW to allow this protocol to be carried out on different microscope 735 

systems. 736 

 737 

SpimFusion was written in CUDA/C++ using Visual Studio 2013 with CUDA toolkit v7.5. Running 738 

SpimFusion requires specific computer hardware: a NVIDIA graphics processing unit (GPU) card 739 

with CUDA compute capability 1.0 or higher and a minimum of 2 GB graphics card memory. At 740 

the time of publication of our protocol, SpimFusion is unpublished (Min Guo and Hari Shroff) but 741 

available in the software bundle archive mentioned above.  742 

http://dispim.org/software/micro-manager
https://micro-manager.org/wiki/ASIdiSPIM_Plugin
https://micro-manager.org/wiki/ASIdiSPIM_Plugin
http://dispimlineage.wormguides.org/
http://run.cytoshow.org/
https://imagej.nih.gov/ij/docs/examples/index.html


   

 743 

A specially built command-line driven version of StarryNite requires that the freely available 744 

MATLAB Compiler Runtime is installed, but does not require a license for commercial MATLAB 745 

software. The MATLAB Compiler Runtime is included in the software bundle archive mentioned 746 

above. The code for StarryNite as used in this protocol is essentially unchanged from that used 747 

for confocal images6. However, several operational matters in the creation of input images for 748 

StarryNite processing and the handling of StarryNite results have been addressed here by 749 

methods in CytoSHOW that enable a continuous data processing pipeline for fused isotropic 750 

diSPIM volumes. These changes are automated by CytoSHOW code that handles these pre-and 751 

post-processing steps. CytoSHOW also edits a pre-optimized diSPIM-specific template StarryNite 752 

parameter set to automatically tune the segmentation algorithm to the fluorescence intensity of 753 

nuclei in the imaged data. The unique parameters used by StarryNite on each diSPIM data set are 754 

then saved in a file along with the output image and lineaging data. 755 

 756 

A custom version of AceTree that works with 16-bit images and maintains compatibility with 757 

Java3D rendering is best suited for this protocol. It is also included in the software bundle archive 758 

mentioned above. 759 

 760 
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Name of Material/ Equipment Company Catalog Number Comments/Description

Steps 1-4
Concavity slides ThermoFisher Scientific 1519006 5-18mm diameter, 0.6-0.8mm deep, 1.2-1.5mm

Dissecting microscope with 10×–50× zoom range Motic SMZ-171

E. coli (OP50) Caenorhabditis Genetics Center (CGC) OP50

Glass coverslips, no. 1.5, 24 × 50 mm VWR International 48393-241

M9 Buffer

Stiernagle, T. Maintenance of C. elegans. WormBook.  1-11, 

doi:10.1895/wormbook.1.101.1, (2006).

Methyl cellulose   Sigma-Aldrich H7509-25G

Microcapillary pipette aspirator tube Sigma-Aldrich A5177

Microcapillary pipettes, 0.4-mm i.d Drummond Scientific 1-000-800

Needle, no. 18G x 1 ½ (1.2mm x 40mm) BD Precision Glide 305196
NGM plates prepared as described by Brenner (1974)

O-ring for imaging chamber O-Rings West M1.5X40

Pasteur pipette Corning/Sigma-Aldrich CLS7095D5X

Platinum wire, 0.5-mm diameter Sigma-Aldrich 267201

Poly-L-lysine Sigma-Aldrich P1524

Stainless steel rectangular chamber (76.0 mm x 50.5 mm) Applied Scientifics Instrumentations (ASI) I2450

Worm Eyelash Pick Hart, A. C. Behavior. WormBook.   (2006).

Worm Pick

Stiernagle, T. Maintenance of C. elegans. WormBook.  1-11, 

doi:10.1895/wormbook.1.101.1, (2006).

Steps 5-6

488 nm long-pass filter Semrock LP02-488 RU-2

561-nm notch filter Semrock NF03-561E-25

BLP02-561R-25, quantity 2 Semrock 561 nm EdgeBasic best-value long-pass edge filter

Control software for bottom camera Jenoptik ProgRes CapturePro 

diSIPM assembly video Applied Scientifics Instrumentations (ASI) https://youtu.be/TAgbr6IrTqw ; http://www.asiimaging.com

diSPIM alignment video Applied Scientifics Instrumentations (ASI) https://youtu.be/qnOrg30NNuE

diSPIM imaging PC Intel Intel Xeon CPU E5-2630 2.6GHz, 12 cores in total, 64 GB memory, Windows 7

FF01-525/45-25, quantity 2 Semrock 525/45 nm BrightLine single-band bandpass filter

FF555-DI03-25X36, quantity 2 Semrock 555 nm edge BrightLine single-edge dichroic beamsplitter

Imaging PC Graphics Card NVIDIDA NVIDIA GeForce GTX 1080 Ti graphics cards

Kumar et al  diSPIM Setup Applied Scientifics Instrumentations (ASI)

Instrument setup for this protocol is identical to Kumar et al 10,11  diSPIM, which 

makes use of 40x 0.8NA water immersion lenses for imaging. (See steps 5.1 and 

note)

Micro Manager Micro-Manager https://micro-manager.org/

Modifications to Kumar et al diSPIM Setup (see below)

Optical table with isolators, 4 feet × 6 feet × 12 inches TMC 784-651-02DR and 14-416-34

Steps 7-10

Analysis PC Intel Intel Core i7-8700K CPU 3.70GHz, 6 cores in total, 64 GB memory, Windows 10

Analysis PC Graphics Card NVIDIDA NVIDIA GeForce GTX 1080 Ti graphics cards

Installation instructions Software bundle http://dispimlineage.wormguides.org/diSPIMlineaging_InstallationInstructions.htm

Software bundle Software bundle http://dispimlineage.wormguides.org
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Title of Article: 

Author(s): 

Item 1: The Author elects to have the Materials be made available (as described at 
http://www.jove.com/publish) via: 

 Standard Access  Open Access

Item 2: Please select one of the following items: 

 The Author is NOT a United States government employee.

 The Author is a United States government employee and the Materials were prepared in the
course of his or her duties as a United States government employee. 

 The Author is a United States government employee but the Materials were NOT prepared in the
course of his or her duties as a United States government employee. 

ARTICLE AND VIDEO LICENSE AGREEMENT 

1. Defined Terms. As used in this Article and Video
License Agreement, the following terms shall have the
following meanings: “Agreement” means this Article and
Video License Agreement; “Article” means the article
specified on the last page of this Agreement, including any
associated materials such as texts, figures, tables, artwork,
abstracts, or summaries contained therein; “Author”
means the author who is a signatory to this Agreement;
“Collective Work” means a work, such as a periodical issue,
anthology or encyclopedia, in which the Materials in their
entirety in unmodified form, along with a number of other
contributions, constituting separate and independent
works in themselves, are assembled into a collective whole; 
“CRC License” means the Creative Commons Attribution-
Non Commercial-No Derivs 3.0 Unported Agreement, the
terms and conditions of which can be found at:
http://creativecommons.org/licenses/by-nc-
nd/3.0/legalcode; “Derivative Work” means a work based
upon the Materials or upon the Materials and other pre-
existing works, such as a translation, musical arrangement,
dramatization, fictionalization, motion picture version,
sound recording, art reproduction, abridgment,
condensation, or any other form in which the Materials may 
be recast, transformed, or adapted; “Institution” means
the institution, listed on the last page of this Agreement, by
which the Author was employed at the time of the creation 
of the Materials; “JoVE” means MyJove Corporation, a
Massachusetts corporation and the publisher of The Journal 
of Visualized Experiments; “Materials” means the Article
and / or the Video; “Parties” means the Author and JoVE;
“Video” means any video(s) made by the Author, alone or
in conjunction with any other parties, or by JoVE or its
affiliates or agents, individually or in collaboration with the
Author or any other parties, incorporating all or any portion 

of the Article, and in which the Author may or may not 
appear. 
2. Background. The Author, who is the author of the 
Article, in order to ensure the dissemination and protection 
of the Article, desires to have the JoVE publish the Article
and create and transmit videos based on the Article. In
furtherance of such goals, the Parties desire to memorialize 
in this Agreement the respective rights of each Party in and 
to the Article and the Video.
3. Grant of Rights in Article. In consideration of JoVE 
agreeing to publish the Article, the Author hereby grants to 
JoVE, subject to Sections 4 and 7 below, the exclusive,
royalty-free, perpetual (for the full term of copyright in the
Article, including any extensions thereto) license (a) to
publish, reproduce, distribute, display and store the Article
in all forms, formats and media whether now known or
hereafter developed (including without limitation in print,
digital and electronic form) throughout the world, (b) to
translate the Article into other languages, create
adaptations, summaries or extracts of the Article or other
Derivative Works (including, without limitation, the Video)
or Collective Works based on all or any portion of the Article 
and exercise all of the rights set forth in (a) above in such
translations, adaptations, summaries, extracts, Derivative
Works or Collective Works and(c) to license others to do any 
or all of the above. The foregoing rights may be exercised in 
all media and formats, whether now known or hereafter
devised, and include the right to make such modifications
as are technically necessary to exercise the rights in other
media and formats. If the “Open Access” box has been
checked in Item 1 above, JoVE and the Author hereby grant
to the public all such rights in the Article as provided in, but
subject to all limitations and requirements set forth in, the
CRC License.

 Leighton H. Duncan, Lin Shao, Mark Moyle, Titas Sengupta, Richard Ikegami, Abhishek Kumar, Min Guo, 
Ryan Christensen, Anthony Santella, Zhirong Bao, William Mohler, Hari Shroff, Daniel A. Colón-Ramos. 
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4. Retention of Rights in Article. Notwithstanding 
the exclusive license granted to JoVE in Section 3 above, the 
Author shall, with respect to the Article, retain the non-
exclusive right to use all or part of the Article for the non-
commercial purpose of giving lectures, presentations or
teaching classes, and to post a copy of the Article on the
Institution’s website or the Author’s personal website, in
each case provided that a link to the Article on the JoVE
website is provided and notice of JoVE’s copyright in the
Article is included. All non-copyright intellectual property
rights in and to the Article, such as patent rights, shall
remain with the Author.
5. Grant of Rights in Video – Standard Access. This
Section 5 applies if the “Standard Access” box has been
checked in Item 1 above or if no box has been checked in
Item 1 above. In consideration of JoVE agreeing to produce,
display or otherwise assist with the Video, the Author
hereby acknowledges and agrees that, Subject to Section 7
below, JoVE is and shall be the sole and exclusive owner of
all rights of any nature, including, without limitation, all
copyrights, in and to the Video. To the extent that, by law,
the Author is deemed, now or at any time in the future, to
have any rights of any nature in or to the Video, the Author
hereby disclaims all such rights and transfers all such rights
to JoVE. 
6. Grant of Rights in Video – Open Access. This
Section 6 applies only if the “Open Access” box has been
checked in Item 1 above. In consideration of JoVE agreeing
to produce, display or otherwise assist with the Video, the
Author hereby grants to JoVE, subject to Section 7 below, 
the exclusive, royalty-free, perpetual (for the full term of
copyright in the Article, including any extensions thereto)
license (a) to publish, reproduce, distribute, display and
store the Video in all forms, formats and media whether
now known or hereafter developed (including without
limitation in print, digital and electronic form) throughout
the world, (b) to translate the Video into other languages,
create adaptations, summaries or extracts of the Video or
other Derivative Works or Collective Works based on all or
any portion of the Video and exercise all of the rights set
forth in (a) above in such translations, adaptations,
summaries, extracts, Derivative Works or Collective Works
and (c) to license others to do any or all of the above. The 
foregoing rights may be exercised in all media and formats,
whether now known or hereafter devised, and include the
right to make such modifications as are technically
necessary to exercise the rights in other media and formats. 
For any Video to which this Section 6 is applicable, JoVE and
the Author hereby grant to the public all such rights in the
Video as provided in, but subject to all limitations and
requirements set forth in, the CRC License.
7. Government Employees. If the Author is a United
States government employee and the Article was prepared
in the course of his or her duties as a United States
government employee, as indicated in Item 2 above, and
any of the licenses or grants granted by the Author
hereunder exceed the scope of the 17 U.S.C. 403, then the
rights granted hereunder shall be limited to the maximum

rights permitted under such statute. In such case, all 
provisions contained herein that are not in conflict with 
such statute shall remain in full force and effect, and all 
provisions contained herein that do so conflict shall be 
deemed to be amended so as to provide to JoVE the 
maximum rights permissible within such statute. 
8. Protection of the Work. The Author(s) authorize
JoVE to take steps in the Author(s) name and on their behalf
if JoVE believes some third party could be infringing or
might infringe the copyright of either the Author’s Article
and/or Video.
9. Likeness, Privacy, Personality. The Author hereby
grants JoVE the right to use the Author’s name, voice,
likeness, picture, photograph, image, biography and
performance in any way, commercial or otherwise, in
connection with the Materials and the sale, promotion and 
distribution thereof. The Author hereby waives any and all
rights he or she may have, relating to his or her appearance 
in the Video or otherwise relating to the Materials, under
all applicable privacy, likeness, personality or similar laws.
10. Author Warranties. The Author represents and
warrants that the Article is original, that it has not been
published, that the copyright interest is owned by the
Author (or, if more than one author is listed at the beginning 
of this Agreement, by such authors collectively) and has not 
been assigned, licensed, or otherwise transferred to any
other party. The Author represents and warrants that the
author(s) listed at the top of this Agreement are the only
authors of the Materials. If more than one author is listed
at the top of this Agreement and if any such author has not
entered into a separate Article and Video License
Agreement with JoVE relating to the Materials, the Author
represents and warrants that the Author has been
authorized by each of the other such authors to execute this 
Agreement on his or her behalf and to bind him or her with 
respect to the terms of this Agreement as if each of them
had been a party hereto as an Author. The Author warrants 
that the use, reproduction, distribution, public or private
performance or display, and/or modification of all or any
portion of the Materials does not and will not violate,
infringe and/or misappropriate the patent, trademark,
intellectual property or other rights of any third party. The
Author represents and warrants that it has and will
continue to comply with all government, institutional and
other regulations, including, without limitation all
institutional, laboratory, hospital, ethical, human and
animal treatment, privacy, and all other rules, regulations,
laws, procedures or guidelines, applicable to the Materials,
and that all research involving human and animal subjects
has been approved by the Author's relevant institutional
review board.
11. JoVE Discretion. If the Author requests the
assistance of JoVE in producing the Video in the Author’s
facility, the Author shall ensure that the presence of JoVE
employees, agents or independent contractors is in
accordance with the relevant regulations of the Author's
institution. If more than one author is listed at the
beginning of this Agreement, JoVE may, in its sole
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discretion, elect not take any action with respect to the 
Article until such time as it has received complete, executed 
Article and Video License Agreements from each such 
author. JoVE reserves the right, in its absolute and sole 
discretion and without giving any reason therefore, to 
accept or decline any work submitted to JoVE. JoVE and its 
employees, agents and independent contractors shall have 
full, unfettered access to the facilities of the Author or of 
the Author’s institution as necessary to make the Video, 
whether actually published or not. JoVE has sole discretion 
as to the method of making and publishing the Materials, 
including, without limitation, to all decisions regarding 
editing, lighting, filming, timing of publication, if any, 
length, quality, content and the like.  
12. Indemnification. The Author agrees to indemnify
JoVE and/or its successors and assigns from and against any 
and all claims, costs, and expenses, including attorney’s
fees, arising out of any breach of any warranty or other
representations contained herein. The Author further
agrees to indemnify and hold harmless JoVE from and
against any and all claims, costs, and expenses, including
attorney’s fees, resulting from the breach by the Author of
any representation or warranty contained herein or from
allegations or instances of violation of intellectual property
rights, damage to the Author’s or the Author’s institution’s
facilities, fraud, libel, defamation, research, equipment,
experiments, property damage, personal injury, violations
of institutional, laboratory, hospital, ethical, human and
animal treatment, privacy or other rules, regulations, laws,
procedures or guidelines, liabilities and other losses or
damages related in any way to the submission of work to
JoVE, making of videos by JoVE, or publication in JoVE or
elsewhere by JoVE. The Author shall be responsible for, and 
shall hold JoVE harmless from, damages caused by lack of
sterilization, lack of cleanliness or by contamination due to

the making of a video by JoVE its employees, agents or 
independent contractors. All sterilization, cleanliness or 
decontamination procedures shall be solely the 
responsibility of the Author and shall be undertaken at the 
Author’s expense. All indemnifications provided herein 
shall include JoVE’s attorney’s fees and costs related to said 
losses or damages. Such indemnification and holding 
harmless shall include such losses or damages incurred by, 
or in connection with, acts or omissions of JoVE, its 
employees, agents or independent contractors. 
13. Fees. To cover the cost incurred for publication,
JoVE must receive payment before production and
publication of the Materials. Payment is due in 21 days of
invoice. Should the Materials not be published due to an
editorial or production decision, these funds will be
returned to the Author. Withdrawal by the Author of any
submitted Materials after final peer review approval will
result in a US$1,200 fee to cover pre-production expenses
incurred by JoVE. If payment is not received by the
completion of filming, production and publication of the
Materials will be suspended until payment is received.
14. Transfer, Governing Law. This Agreement may be
assigned by JoVE and shall inure to the benefits of any of
JoVE’s successors and assignees. This Agreement shall be
governed and construed by the internal laws of the
Commonwealth of Massachusetts without giving effect to
any conflict of law provision thereunder. This Agreement
may be executed in counterparts, each of which shall be
deemed an original, but all of which together shall be
deemed to me one and the same agreement. A signed copy 
of this Agreement delivered by facsimile, e-mail or other
means of electronic transmission shall be deemed to have
the same legal effect as delivery of an original signed copy
of this Agreement.

A signed copy of this document must be sent with all new submissions. Only one Agreement is required per submission. 
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Editorial comments 
 
General:  
 
1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there 
are no spelling or grammar issues. 
We have carefully proofread the manuscript and corrected all spelling and grammatical issues.  
 
2. Please number references in the order in which they appear in the manuscript–currently, 5 
appears before 2-4. 
We have made sure that all number references are in the order in which they appear.  
 
3. Note that the “Glossary” is not part of JoVE format; please remove and ensure that all 
relevant terms are defined on first use. 
We have removed the “glossary” section and defined all relevant terms upon first use.  
 
4. Please reduce the number of personal pronouns (you, we), in particular in the Protocol. 
We have removed all personal pronouns (you, we) from the protocol. 
 
5. JoVE cannot publish manuscripts containing commercial language. This includes trademark 
symbols (™), registered symbols (®), and company names before an instrument or reagent. 
Please limit the use of commercial language from your manuscript and use generic terms 
instead. All commercial products should be sufficiently referenced in the Table of Materials 
and Reagents. For example: Milli-Q, Sigma-Aldrich, BD Precision Glide. 
We have made sure all commercial language was removed from the manuscript and referenced 
in the Table of Materials and Reagents.  
 
Summary: 
 
1. Please include a Summary that clearly describes the protocol and its applications in 
complete sentences between 10 and 50 words, e.g., “Here, we present a protocol to …” 
We have included a summary that describes the protocol and its applications in complete 
sentences.  
 
Protocol: 
 
1. There is a 10-page limit for the Protocol, but there is a 2.75-page limit for filmable content. 
Please highlight 2.75 pages or less of the Protocol (including headers and spacing) that 
identifies the essential steps of the protocol for the video, i.e., the steps that should be 
visualized to tell the most cohesive story of the Protocol. Remember that non-highlighted 
Protocol steps will remain in the manuscript, and therefore will still be available to the 
reader. 



We have highlighted 2.75 pages of the protocol that identify the essential steps of the protocol 
for the video.  
 
2. Please ensure that all text in the protocol section is written in the imperative tense as if 
telling someone how to do the technique. Any text that cannot be written in the imperative 
tense may be added as a “Note” on a separate line.  
We have made sure all text in the protocol sections are written in the imperative tense. Any 
text that could not be written in the imperative tense was added as a “note” on a separate line.  
 
3. The Protocol should contain only numbered action items that direct the reader to do 
something or brief ‘Notes’. Please move the other statements about the protocol (e.g., the 
introductory statement in steps 10 and 11) to the Introduction or Discussion, as appropriate.  
We have revised the protocol to contain only numbered action items that direct the reader to 
do something. We have moved the introductory statements in steps 10 and 11 to parts of 
introduction or discussion, as appropriate.  
 
4. The Protocol should be made up almost entirely of discrete steps without large paragraphs 
of text. Please split up Protocol steps so that individual steps contain only 2–3 actions and a 
maximum of 4 sentences. 
We have revised the protocol as suggested.  
 
5. For each step, please ensure you answer the “how” question, i.e., how is the step 
performed? Alternatively, add references to published material specifying how to perform 
the protocol action. If revisions cause a step to have more than 2-3 actions and 4 sentences 
per step, please split into separate steps or substeps. 
We have revised the protocol as suggested.  
 
Specific Protocol steps: 
 
1. 1.1: Please write in the imperative. Also, do you mean 2 mm x 5 mm? 
We have revised 1.1 to be imperative and corrected the coverslip dimension 2x5mm2 to 2mm x 
5mm.  
 
Figures: 
 
1. Please remove titles and legends from Figures and include in the manuscript. 
We have removed titles and legends from figures and include them in the manuscript. Figures 
are included as eps files. 
 
2. Figure 6: Please use ‘minutes’ or ‘min’, not ‘mins’. 
We have modified figure 6 as suggested.  
 
Discussion: 



 
1. Discussion: As we are a methods journal, please revise the Discussion to explicitly cover the 
following in detail in 3–6 paragraphs with citations: 
a) Critical steps within the protocol  
b) Any modifications and troubleshooting of the technique 
c) Any limitations of the technique 
d) The significance with respect to existing methods  
We have revised the discussion to explicitly cover the suggestions above in 3-6 paragraphs with 
citations.  
 
Table of Materials: 
 
1. Please ensure the Table of Materials has information on all materials and equipment used, 
especially those mentioned in the Protocol. 
We have revised and ensured that the Table of Materials has information on all materials and 
equipment used in the protocol.  
 
Reviewer #1 
 
Minor concerns: 
 
1. It may be beyond the authors' capabilities, but hardware-accelerated video image 
processing relies on specific features of graphic card chipsets. Is it possible to use GPUs from 
other manufacturers like an AMD Radeon card, and if so what model(s)? 
We have now added a section at the end of the discussion explaining software compatibility 
and download access. Briefly, in principle, it's possible to use GPUs from other manufacturers. 
However, our current software was developed based on NVIDIA's CUDA toolkit which specially 
supports GPUs from NVIDIA only. To use GPUs from other manufacturers, we would need to 
modify some of the basic modules in our codes. i.e. replace the CUDA functions by some new 
and customized function or by employing some other libraries compatible with non-NVIDIA 
GPUs, such as OpenGL. Such changes would also be compatible with only a subset of GPU 
hardware, and would sacrifice the power of native CUDA execution that is essential to our 
streamlined data-processing pipeline.  
 
2. line 153 - 1-cell, and even 2-cell embryos are osmotically sensitive and can develop 
abnormally if not in isotonic buffer. This can be problematic if pseudocleavage embryos 
(which look like 2-cell) are chosen because these may not develop properly. 
M9 Buffer is an isotonic buffer which helps prevent early stage (1-cell or even 2-cell) embryos 
succumbing to abnormal osmotic pressure. We have included (see step 1.6 in protocol) our 
rational for using M9 as our imaging buffer during imagine. Also, in response to the reviewer 
observation, we now emphasize this point in the protocol.  Interestingly, M9 is phosphate 
buffered, which itself reduces viability of newly fertilized embryos, before maturation of the 
vitelline envelope and eggshell.  This may actually select against seeing pseudocleavage 
embryos in our preparations, as we virtually never encounter non-viable embryos among our 



mounted specimens. To note, we have seen more embryos arrested at the 3-fold stage when 
M9 is substituted with water. 
 
Reviewer #2 
 
Minor Concerns: 
 
1. How long will the video end up being? 
diSPIM is capable of long-term imaging, and we have imaged the entire C. elegans 
embryogenesis with the diSPIM for a total of 14 hours at 20oC. In response to the reviewer’s 
question, we now add a sentence mentioning this in the introduction. 
  
Reviewer #3 
 
Major Concerns: 
 
1. One of the major pitfalls of the protocol is the (incorrect) assumption that most labs have 
access to their own diSPIM. This technology is not yet broadly accessible, although this is 
improving, and I agree that it will be important to have protocols for labs to be able to 
analyze large datasets in a way that is consistent with previous studies in the field. Since most 
labs who use diSPIM will use one in a core facility that is not specifically designed for C. 
elegans use, it is crucial to provide more information on the specs of the diSPIM used for this 
protocol and how this one compares to the more popular microscopes in core facilities (e.g. 
Zeiss, etc). For example, more on the objectives (magnification), light path, camera, imaging 
chambers. This is important, because if a system has lower magnification or different NA 
objectives, will they be able to obtain the same quality of information with the same 
subcellular resolution? What threshold is required? 
The reviewer correctly understands that the ASI diSPIM is based on a design that was conceived 
and developed from the ground up for C. elegans embryological imaging.  To our knowledge, 
other multi-view SPIM systems that are commercially available differ markedly in the geometry 
and optics of the sample chamber.  In fact, we are not aware of another commercial system 
that uses direct aqueous-immersion objectives within the sample chamber.  We reasonably 
expect that refractive aberrations from glass capillaries and other multi-indexed refraction light 
paths will severely degrade the raw image data captured on Zeiss and other common 
commercial SPIMs.  While we have not tested such other hardware for lineaging experiments, 
we cannot recommend it based on our a priori knowledge of the major differences in their 
architecture. A previous paper describes the conception of the diSPIM format (Kumar et al, 
2016) with all of the details requested by the reviewer.  Specifically, the reviewer’s concern 
with objective magnification and numerical aperture (NA) is an excellent observation; both 
objectives are 40x 0.8NA water immersion lenses.  We fully expect that lower mag or 
higher/lower NA (yes…higher, as light-sheet thinness is dependent on minimizing NA) 
objectives would degrade the raw image quality and possibly the isotropy of the final processed 
images. Detailed information on the specs and available objectives of the diSPIM are available 



at the following links: http://dispim.org/hardware/objectives; http://www.asiimaging.com.  We 
have added these links to the text of the paper (see step 5.2 in protocol). 
 
2. Also, other systems likely will use acquisition software other than micromanager, so how 
could data collected using other 'common' software (e.g. metamorph) be integrated into this 
protocol? 
CytoSHOW is capable of processing MetaMorph TIFF stack series, or TIFF stack series exported 
from other imaging systems with differing primary image storage formats.  Yet, this processing 
option currently can only be applied to a single specimen at a time. Only primary data from the 
ASI diSPIM Micro-Manager plugin can currently be processed simultaneously as parallel batches 
of co-imaged specimens. We have added a section at the end of the discussion explaining 
software compatibility and download access.   
 
3. Another major concern is that the authors state in their conclusions that this protocol will 
enable users to quantify growth cones and axon fasciculation, but they did not show or 
describe this in their protocol. The protocol focused on nuclear tracking. In the figures, the 
authors show beautiful images of a marker expressed in a subset of neuronal cells that could 
be used to extract and quantify morphological information, but they did not do this. The 
authors should give an example of how to quantify one of these features as a proof-of-
concept, since it is described as a major feature of this protocol. 
We appreciate the reviewer’s comments regarding a proof-of-concept example of how to 
quantify neuronal features using our integrated protocol. To satisfy this concern, we have 
quantified the neurite migration of the RMDDs in the early twitching embryo (see new Figure 
7I). In Figure 7I, we quantified the lengths of the left and right RMDDs from 360 minutes to 445 
minutes post fertilization. The neurite lengths of the RMDDs were measured using the “simple 
neurite tracing” plugin in FIJI. This example now illustrates, as suggested, how this integrated 
protocol will enable users to quantify dynamic neurodevelopmental events in single cells of 
intact embryos.  
 
Minor Concerns: 
 
1. The authors may think it isn't warranted, but I see the advantage of using diSPIM to study 
morphogenetic events during C. elegans embryogenesis is that you could obtain information 
after the 2-fold stage when the embryo is moving, because of the fast rates of acquisition. I 
could see this as providing new information to the field that has been missed because 
previous technologies simply could never permit obtaining this information. However, the 
authors stop their experiments at the 2-fold stage because the embryo is moving. At what 
stage of embryogenesis is the rate of acquisition unable to compensate for movement? Or is 
this not a factor, but it is too complicated to align the images for multiple z for a single time 
point for this protocol? 
We agree with reviewer 3 that using diSPIM to study C. elegans development in the post-
twitching embryo is warranted and interesting.  The diSPIM has indeed demonstrated a 
promising capability to image neurodevelopmental events and track cell position in the post-
twitching stages of embryogenesis (Wu et al, 2013, Christensen et al, 2015, Ardiel et al, 2017).  

http://dispim.org/hardware/objectives
http://www.asiimaging.com/


However, automated lineaging in the post-twitching embryo is currently not feasible.  Nuclear 
positions change on the order of seconds in the post-twitching embryo.  That is why we limited 
discussion of the integrated protocol, which includes lineaging, to pre-twitching. We now 
explain this point in the discussion. 
 
2. Just to clarify, is the role of methyl-cellulose to increase viscosity or is there another reason 
for using it? 
In response to the reviewer question, we have added a note explaining why we use methyl 
cellulose in our sample prep. (see step 2.2 and note in protocol).  We explain that methyl 
cellulose suspends embryos above the glass surface of the concave watch glass, to which 
embryonic eggshells tend to stick in its absence.  
 
3. Figure 1-C, the schematic representation of the top half of the steel chamber is misleading. 
I look like a plain piece, and it is difficult to understand how to mount embryos on the 
coverslip. 
We thank the reviewer for this observation, and have now revised figure 1C to make it easier to 
understand how to assemble the diSPIM chamber and mount embryos on the coverslip.  
 
4. More information on what to expect for the size of the files generated during acquisition 
and recommended storage solutions would be useful. Also, other computer specs for 
acquisition would be helpful. 
We have now included additional computer specs for acquisition in parts of the protocol and 
Tables of Materials. Briefly and as we now explain in the text, we typically capture 420 time 
points for 10 embryos per imaging session. The raw data per image session are typically 1.7TB, 
while deconvolved and StarryNite-processed data are 1.4TB. We recommend using large-
capacity HDD (e.g. 18TB on our current system) for image acquisition, and cloud platforms such 
as DropBox or Box for long-term file storage.   
 
5. In section 5-3 - just a minor text change - "During long-term imaging, we typically image 
nuclei (mCherry::Histone) by capturing images from the 561 nm channel until embryos are at 
bean stage, at which point we use the 488 nm channel to image the GFP-labeled neurons." 
This sounds like you stop imaging the 561 nm channel. Add the word 'also'. 
We have revised the text in this section as recommended. (See section 5.4 in protocol) 
 
6. Line 544: "~435 minutes poster fertilization" I assume you mean post fertilization. 
We have now corrected the typo. 
 
7. Since it is common to adapt protocols to other model systems, can you think of another 
system that this approach could be used for? This is where the specs could be helpful - e.g. 
size and sample thickness. 
With the same 40x, 0.8 NA objectives, ASI diSPIMs are regularly used to image C. elegans, 
Drosophila and zebrafish embryos. We have also imaged other model systems such as plant 
cells, yeast cells, and hydra (many of these imaging sessions were conducted during summer 
courses at the Marine Biological Laboratories in Woods Hole, MA). However, the integrated 



protocol with the lineage analyses as described is still currently limited to nematode species. 
Moreover, we often opt to use stage-scanning diSPIM to obtain high-quality images from the 
diSPIM (Kumar et al, 2016). In response to the reviewer question, we now added a note about 
the option of using stage-scanning with thick samples in the discussion and referenced Kumar 
et al. 
 
Reviewer 4 
 
Major Concerns: 
 
1. The complete procedure will be deposited on the web (www.wormguides.org), but is not 
yet available for evaluation. Some details are referred to reference 16 (Min Guo et al. in 
preparation). However, I expect these issues would be resolved before publication. 
We have now uploaded the software installation archive with instructions to the WormGUIDES 
website (http://diSPIMlineage.wormGUIDES.org). We have also added a supplementary section 
at end of the discussion providing this link to users for download. 
 
Minor Concerns: 
 
1. References are out of order and a reference to WormBase would be useful. It is not clear 
whether the user needs to own the program MatLab. Protocol step 1.2 should be re-ordered. 
We have now edited the manuscript, including adding the WormBase reference, as requested 
by the reviewer. We have also added a supplementary section at the end of discussion detailing 
software compatibility and download access, including an explanation that all software 
packages used in the protocol are open-source and freely available for use without the need of 
MATLAB or other commercial software.  
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